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4.1. Creating a Macro with the Macro Wizard 
 
The Macro Wizard is a quick and easy way to create any of the three types of macros (Text, Key, or 
Launch). It walks you through each step necessary to create a macro. Simply make your 
selections/entries in each window and click Next to move to the following window. Once you have 
completed each step, click Finish and your new macro is added!  
 

 
 
To access the Macro Wizard, either 
 
Select Macro Wizard from the Tools menu. 
- or - 
Click the Macro Wizard button on the toolbar. 
 
Use the Macro Wizard to walk you step by step through the process of creating a macro:  
  
Action  
Choose the action your macro will perform.  It can carry out simple commands, open an 
application, work with web pages, send email, display a QuickList (see QuickLists), modify 
windows, work with files, work with folders, or open administrative applications such as Control 
Panel items.   
 
Macro  
Define the macro in this step, either by typing commands or by using the Insert Command button, 
which allows you to select from all commands that are available for the type of macro you chose in 
the first step. (See Macro Properties for detailed descriptions of the options in this step.)  
 
Name and Description  
Name your macro in the name field.  Your macro must have a name so that you can reference it 
later.  You can enter a description or notes in the description field.  
 



Properties  
Enter any shortcuts that you would like to use to run this macro.  (See Macro Properties for 
detailed descriptions of the options in this step.)  
 
Folder  
Choose the folder in which to save this macro.  
 
Finished  
Click Finish to create and save this macro, Back to return to any of the previous screens, or Cancel 
to discard this new macro. 
 



4.6. Creating Special Command Macros 

4.6.1. Creating QuickLists 
 
A QuickList is a special macro that opens a window containing a list of other macros.  In other 
words, a QuickList is a stand-alone menu of macros. 
 
QuickLists are especially useful if you have a set of macros that you use often or that you tend 
to use together, you don't want to assign and remember shortcut keys for each macro, and you 
don't want to open the AIM Keys editor each time you need to run one of those macros. 
 
For example, if you have several macros that you use every day, you could build a "Most-used 
Macros" QuickList that contains each of those macros.  You can use a shortcut to open the "Most 
Used Macros" QuickList, then easily run the macros in it by double-clicking them or hitting their 
hotkeys. (See "Hotkey playback" in QuickList Properties below.)  You even have the option of 
closing the QuickList automatically once you choose a macro to run. (See "Remain open after 
selection" in QuickList Properties below.) 

4.6.1.1. Creating a QuickList 
 
1. In the Folder Pane of the file window, select the folder where you want to add a new QuickList. 
 
 
TIP: To avoid confusion, we recommend putting QuickList macros in a separate folder, such as a 
Special Commands folder. 
 
 
2. Do one of the following to display the Macro Properties dialog box: 

• From the Insert menu on the menu bar, select Add Macro. 
• Click the Add Macro button on the toolbar. 
• Press CTRL+I. 
• Right-click in the Macro Pane and select Add Macro. 
 
 



The Macro Properties dialog box appears. 
 

 
 

3. Enter a name for the macro in the Name field. 
4. With the cursor in the Macro Syntax field, click the Insert Syntax button.  

 



The Insert Syntax dialog box appears. 
 

 
 
5. In the Insert Syntax dialog box, click Misc. and do one of the following: 

• Select QuickList and click Insert. 
• Double-click QuickList. 



6. The Insert QuickList dialog box appears. Specify the properties for the new QuickList. 
 

 
 

7. Click the Insert button. 
8. The QuickList syntax appears in the Macro Syntax field. 
9. Set the desired properties for the macro (see Macro Properties for full details). 
10. Click OK. 
11. Click Save on the Macro Manager toolbar to save the file. 

 
Like other macros, QuickLists can be edited through the Macro Properties dialog. 
 
 
 
NOTES: 
The items in the QuickList are checked for validity each time the QuickList is modified.  If an item 
has been deleted from the current .akm file, it will automatically be removed from the QuickList. 
 



The AIM Keys 5.0 QuickList macro uses a new syntax, so older versions of AIM Keys cannot run 5.0 
QuickLists.  AIM Keys 5.0 can run QuickLists that were built in previous versions, but it is 
recommended that you update the format of your older QuickLists by opening the QuickList for 
editing (via the Edit Syntax button of the Macro Properties dialog), which automatically converts it 
to the new format. 

 
4.6.1.2. QuickList Properties 

 

 
 
Window desired title 
Type a name for the QuickList macro.  When you run the QuickList, this will also be the text 
displayed in the title bar of the QuickList window. 
  
Help text 
You can modify this Help text, which will be displayed at the top of your QuickList. 



  
Items 
This is the list of items the QuickList will display.  You can modify the Items list using the Add, 
Remove, Up, and Down buttons. 
  
Add 
Opens a dialog box that will let you choose a macro to add to the Items list. 
  
Remove 
Removes the selected macro from the Items list. 
  
Up 
Moves the selected item up within the Items list.  This is useful because the QuickList will allow you 
to use numeric shortcuts based on a macro's position in the list. 
  
Down 
Moves the selected item down within the Items list. 
  
Position: Exact  
You can specify an absolute initial screen position for the QuickList by specifying X and Y 
coordinates, in pixels.  
  
Position: Use mouse position  
Select this option to have the QuickList appear where the mouse cursor is pointing when the 
QuickList macro is triggered. 
  
Position: Center screen  
Select this option to center the QuickList on the screen when it first appears. 
  
Initial height 
Use this field to set the number of items visible in this QuickList by default. 
  
Initial width 
Use this field to set the width of the QuickList window. 
  
Always on top  
Check this box if you want this QuickList window to remain on top of all other windows on your 
screen. 
  
Remain open after selection  
Check this box if you want this QuickList to stay open after you have selected a macro to play 
back.  If this box is not selected, the QuickList window will automatically close after you have 
triggered a macro from it. 
  
Visible columns 
Select which macro attributes should be visible in the QuickList window. 
  
Hotkey playback 
These options determine how the QuickList will identify the macros listed in it.  If you choose 
numerical identifiers, for example, then you will be able to use the number 1 to trigger the first 
macro in the list. 



4.6.2. Creating Internet Form Filling Macros 
 
The Internet Form Filling Macro (new in AIM Keys 5.0) can be used to autofill web forms in Internet 
Explorer. 
 
This type of macro allows you to quickly and automatically fill out and even submit web forms.  For 
example, if your inventory system is accessed via browser and you need to enter 100 new items, 
but the basic information about each item is the same, you can use a form-filling macro to 
automatically insert the basic information into the corresponding fields in the web form.  You need 
only enter the information that is unique to each item before submitting the form.  
 
Since you can also use an existing macro to define the content of a field (see description under 
"Current item" in Form Filling Macro Properties below), you can auto-fill date and time, pull data 
from a spreadsheet, or use just about any other data source you can imagine.  For example, 
if every Friday you use a particular web site to check the week's history for a particular stock, you 
can define a macro that will automatically fill in the stock's identifier, fill in the start date to be four 
days ago (Monday) and the end date to be today, and submit the form. 
 

4.6.2.1. Creating an Internet Form Filling Macro 
 
1. In the Folder Pane of the main window, select the folder where you want to add a new macro. 
2. Do one of the following: 

• Select Add Macro from the Insert menu. 
• Click the Add Macro button on the toolbar. 
• Press CTRL+I. 
• Right-click in the Macro Pane and select Add Macro. 
 
 



The Macro Properties dialog box appears. 
 

 
 

3. Enter a name for the macro in the Name field and (optionally) add a description in the 
Description field. 

4. With the cursor in the Macro Syntax field, click the Insert Syntax button. 
 



 
 

5. In the Insert Syntax dialog box, click Misc and double-click Web Form Fill, or select Web 
Form Fill and click Insert. 

6. The AutoFill Form dialog box opens and provides the options in the next section. 
 
 



4.6.2.2. Internet Form Filling Macro Properties 

 

 
 
Website 
Enter the URL (internet address) of the page where this macro will fill in form information.  Be sure 
to enter the full address (beginning with "http"). 
  
Open 
Click this button to open an Internet Explorer window to the page entered above.  You can use this 
function to double-check the URL. 
  
Autodetect 
Click this button to import all the form information, including form and field names, from the web 
page entered above.  If an item has a default value, that value will be imported. 
If you have already imported and edited this information, clicking this button will overwrite the 
previous information. 
  
Available Forms 
This list displays all the forms on the page.  Select one to display its available fields. 
  
 
 



Available Items 
This list displays all items or fields in the currently selected form.  (Hidden fields are not displayed.)  
Select an item to edit its properties. 
  
Current Item 
This section allows you to edit the current item's contents directly.  It also offers the "bind to a 
macro" option, which allows you to use a macro to define the item's contents. 
Note that this section will look like a text box, list box, button, or other form element to reflect the 
field type of the current item. 
 



5.3. Macro Scoping 
 
Macro scoping (new in AIM Keys 5) allows you to specify where a macro can run. 
 
For example, if you have a macro that is designed specifically for your spreadsheet application but 
that might cause problems in other programs, you can specify that this macro is only allowed to 
run in your spreadsheet application.  (See "Only within these applications" in the list below.)  
 
You can also allow a macro to run everywhere except in specified applications, which is useful when 
a macro is effective in most programs but has unintended results in others.  (See "All applications 
except these" in the list below.) 
 
Using macro scoping, you can even have one shortcut trigger different macros, depending on which 
application is in focus.  As a simple example, you might want to insert short dates in your 
spreadsheet application, but long dates in your word processor.  You can write one macro that only 
runs in the spreadsheet program and inserts a short date, and a second macro that only runs in 
the word processor and inserts a long date.  By assigning the same shortcut to both macros, you 
only have to remember one shortcut, and AIM Keys remembers which date format to enter in 
which application. 
 
To view the current scope of a macro from the main AIM Keys window, select the macro in the top 
pane and open the Properties tab in the bottom pane.  
 

 



 
To define the scope of an individual macro, access the Macro Scoping dialog by clicking the Scope 
button in the Macro Properties dialog. 
 
To define the scope of all the macros in a folder, access the Macro Scoping dialog by clicking the 
Scope button in the Folder Properties dialog. 
 
 
NOTES: Folder scope settings override individual macro scope settings.  If you change the scope 
settings on a folder that contains macros with a non-default scope, AIM Keys will warn you before 
saving the folder scope settings. 
 
The addition of the scope feature to AIM Keys 5.0 required changes to the .akm file format.  Older 
versions of AIM Keys are not able to open .akm files produced with the 5.0 version. 
 
 
Use the following options to define the scope of your macros:  
 

 
 
 
Globally 
This default option allows the macro to run anywhere. 
  
Only within these applications:  
This option allows the macro to run within the specified applications only. 



  
All applications except these:  
This option allows the macro to run anywhere except the specified applications. 
  
Add  
Click this button to add an application to the list (see Target Icon Button and Edit Box below). 
  
Remove 
Click this button to remove the selected application from the list. 
 
Target Icon Button 
Use this button to select applications to add to the inclusion/exclusion list.  First, open the 
application you wish to select.  Then drag the Target icon and drop it onto that application.  This 
automatically fills in the name of the application in the Edit box (below).   
  
Edit box 
Type the name of the application you wish to add to the inclusion/exclusion list, and click the Add 
button.  Application titles that are chosen using the Target Icon appear here, and can be edited 
before clicking the Add button. 
  
Retrieve by window title 
Choose this option if you want AIM Keys to identify applications based on window title (the text in 
the bar at the top of the application window).  This option can be used to differentiate between 
instances of the same application. 
  
Retrieve by window type 
Choose this option if you want AIM Keys to identify applications based on the application type.  Use 
this option when the title of an application changes often, or does not contain a useful identifier.  
This option matches all instances of an application. 
 


